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Section 1: Introduction

Introduction

Section 1:	Introduction
This manual contains specifications, installation, operating, and maintenance information for 
Communication Adapter Module (CAM216/16) Model No. 6 with HART option.

The CAM16 is used with Valve Automation M2CP, MPA, HQDCM33 and EHO valve actuators, 
whereas the CAM216 is used with the TEC2, TEC2000 and Model 500. Functionality of the 
actuator using the HART option supports both block valve (On/Off control) and modulating/
positioning control. This manual also describes actuator setup using the HART specified 
Device Description (DD), parameter access, and methods. Display and control using these 
parameters depend on the SCADA or DCS host software being used. Refer to the host software 
documentation for information on executing methods and accessing parameters.

1.1	 HART CAM16/216 Specifications

Table 1.	 Card and Device Type

Product Name Expanded Device Type Applicable Devices

CAM16 0xE28B (Hex)
M2CP
MPA
HQ

CAM216 0xE28C (Hex)

Model 500
TEC2000
TEC2
EHO

Table 2.	 General Device Information

Type Specifications
Manufacturer Name Valve Automation
Manufacturer ID 0x6060 (Hex) 
HART Protocol Revision 7.5
Device Revision 01 
DD Revision 01 

Table 3.	 HART Device Variables

Device Variable Code Device Variable Name Units 
0 Setpoint % 
1 Position % 
2 Torque % 
3 Analog Input 1 % 
4 Analog Input 2 % 
5 Analog Output 1 % 
6 Analog Output 2 % 
7 Hydraulic Pressure PSI (Pounds Per Square Inch) 
8 Accumulator Pressure PSI (Pounds Per Square Inch) 
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Table 4.	 Dynamic Variables

Sr. No. Dynamic Variable Default Assignment Valid Range 
1 Primary Variable 0: Setpoint 0: Setpoint

2 
Secondary Variable 1: Position 0: Setpoint

1: Position

3

Tertiary Variable 2: Torque 2: Torque 
3: Analog Input 1 
4: Analog Input 2 
5: Analog Output 1 
6: Analog Output 2 
7: Hydraulic Pressure 
8: Accumulator Pressure 

4

Quaternary Variable 3: Analog Input 1 2: Torque 
3: Analog Input 1 
4: Analog Input 2 
5: Analog Output 1 
6: Analog Output 2 
7: Hydraulic Pressure 
8: Accumulator Pressure

Table 5.	 Device Physical Information

Type Specifications
Electrical Input HART Interface
Voltage Level 10 to 18 VDC
Nominal Current 50 mA
Reverse Polarity Protection Polarity Sensitive
Digital Communication Protocol 1200bps binary phase continuous Frequency Shift Keying (FSK)
Operating Ambient Temperature Limits -40°C to 80°C (-40°F to 175°F)

1.2	 HART Protocol and Device  
Description (DD) Information

Valve Automation electric motor actuators equipped with CAM16/216 option use HART 
protocol to communicate with other HART devices and a compatible host system. The HART 
Communications Protocol communicates over 4-20mA instrumentation cable which permits 
an easy upgrade path for legacy instrumentation systems to migrate into a digital industrial 
automation protocol.

A HART DD is used to describe the characteristics of the field device to the Host. For more 
details on the Device Descriptor (DD) please refer to Section 9: Device Descriptor.

When manual installation of the DD is required, please refer to the Emerson Website to find the 
latest version of the HART CAM16/216 for download. Alternatively, the DD can be downloaded 
directly from the HART Foundation website at https://en.hartcomm.org for third party hosts.

Navigate to Technology | Device Descriptions | DD library | Product Catalogue | and locate 
the CAM16 or CAM216 DD respectively.
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HART technology uses DD to achieve interoperability between actuators and control systems 
or hosts from various manufacturers. For HART devices, in addition to providing parameter 
definitions and information required by the control system to communicate with the HART 
device, the DD may also include methods.

1.3	 Disclaimer

All rights reserved. No part of this document shall be reproduced, stored in a retrieval system, 
or transmitted by any means, electronic, mechanical, photocopying, recording, or otherwise 
without the express written permission of Valve Automation. While every precaution has 
been taken in the preparation of this document, the publisher and Valve Automation assume 
no responsibility for technical or editorial errors, omissions made herein; nor for incidental 
or consequential damages resulting from the performance or use of this document and the 
information, apparatus, or methods of operations disclosed within this document.

 WARNING: 
Failure to follow instructions for proper electrical wiring, storage, setup, and maintenance 
may cause serious injury, damage equipment, or void the warranty. Refer to Manual E796 for 
instructions on storage, electrical hook-up and maintenance.

 CAUTION: 
Actuator failure or integral electronic controller configuration or setup beyond that is described 
in this manual must be performed only by qualified Valve Automation personnel. Upgrades or 
reconfiguration of existing actuators must be performed only by qualified Valve Automation 
personnel. Repairs must be performed only by qualified Valve Automation personnel.

 

NOTE:  

Advisory and information comments provided to assist personnel through additional details 
and notable procedures

1.4	 Actuator Description

Emerson Process Management electric actuators with HART option are microprocessor-based, 
interoperable, process controllers, communicating with other valve actuators and types of 
sensors and process control equipment. In addition to the primary function of controlling 
the position of the valve, the Emerson Process Management electric actuator, using HART 
communications protocol, gives easy access to information critical to process control. You can 
gain information from the principal component of the process, the control valve itself, by using 
a personal computer or operator’s console within the control room.

Using a compatible HART configuration device, you can obtain information about the health of 
the actuator and valve. You can also obtain parameter access information about the actuator. 
You can set input and output configuration parameters and calibrate the actuator. Using the 
HART protocol, information from the actuator can be readily integrated into control systems 
and process control strategies.
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1.5	 Related Information

1.5.1	 HART Installation and Guidelines

—— HART Communication Protocol Specification (HCF_SPEC-13)

—— FSK Physical Layer Specification (HCF_SPEC-54)

—— Network Management Specification (HCF_SPEC-85)

1.5.2	 Other Related Information 
Other documents containing information related to the Valve Automation  
Actuators include:

—— Controlinc Quick Startup Guide, Document number ECL-400-1000 

—— Valve Automation series 2000 M2CP Installation and Maintenance Manual, 
Document number E796

—— Multi-Port Actuator Operation and Manintenance Manual, Document number 
MPA-400-0711

—— Digital Futronic HQ DCM 33 Operation Manual

1.6	 Specifications

Specifications for the HART portion of the Valve Automation Actuator with CAM16/216 option 
are provided below. Refer to the Valve Automation series 2000 IOM Manuals for specifications 
on the basic Valve Automation actuator device.

•	 Electrical Input  
- HART Interface

•	 Voltage Level  
10 to 18 VDC

•	 Nominal Current  
50 mA

•	 Reverse Polarity Protection  
Unit is polarity sensitive and +/- is clearly marked for referencing. If the module is 
connected with reverse polarity, it will not operate and board may get damaged.

•	 Digital Communication Protocol 
1200 bps binary phase continuous Frequency Shift Keying (FSK)

•	 Operating Ambient Temperature Limits 
-40°C to 80°C (-40°F to 175°F)

NOTE:  

Temperatures below -40°C requires a low temperature actuator option.

•	 Network Connection  
Terminal Block with two elevator type screw terminals

•	 Auxiliary Digital Outputs  
Quantity and Type – Two, Independent isolated Form 'A' dry contact relays 
Voltage – 250 VAC or 30 VDC 
Current – 5 Amps resistive, 2 Amps inductive
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•	 Auxiliary Digital Inputs 
Quantity and Type – Two, Independent opto-isolated with high-side and  
low-side sensing 
Voltage – 10-30 VDC 
Current – 4 mA maximum turn-off, 10 mA minimum turn-on, 12 mA typical at 24 VDC

•	 Auxiliary Analog Inputs 
Two, 4-20 mA (24 VDC power available from actuator to power all auxiliary I/O)

•	 Optional Analog Output (Option must be specified at Time of Order) 
One, 4-20 mA
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Section 2:	Installation of CAM16
CAM16 is supported by M2CP, HQ, EHO and MPA electric actuators when equipped with the 
proper networking features. Emerson Process Management electric actuators equipped with 
HART CAM16 option require a main power source. This source will power the electric motor 
and all electronic controls including the CAM16. The CAM16 HART interface is powered directly 
from the device, and is not capable of communication when the actuator does not have power. 
Refer to the site planning guide for proper wire types, termination and length into an Emerson 
Process Management electric actuator.

Figure 1	 CAM16 Card

              	

Mounting Holes

Connector J4

J5

2.1	 Installation of HART CAM16 in 320B M2CP Unit

1.	 After removing power from the device, remove the front cover to expose the internal 
electronics. Locate and unplug the TBM 320A board located inside the control housing 
by loosening screws (A) and (B) and carefully pulling the board forward to expose the 
mounting location for the CAM16 board (no wires need to be disconnected).

Figure 2	 CAM16 Screw Mounts
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2.	 Lower the TBM 320A board without disconnecting the wires attached on the sides and 
bottom. This will provide access to the 320B board.

Figure 3	 Accessing the 320B Board

	

3.	 Locate the J2 connector on the 320B Board, and connect to the J3 connection on the 
CAM16. Align the J2 to J3 and the 3 white plastic holders to mount the CAM16 in place.

4.	 Follow Step 5, 6 or 7 depending on desired HART Network type:

Table 6.	 HART Control Types (1)

Control Type Step to Follow
HART – Analog Control (Point-to-Point) Step 5
HART – Digital Control (Multi-Drop) Step 6
HART – Digital Control (Wireless THUM) Step 7

5.	 HART Analog Control (Point-to-Point; Actuator Must be in Analog Control Mode)

a.	 Connect the HART Analog 4 – 20 mA input signal as follows:

Table 7.	 HART Control Types (2)

4 – 20 mA Connector J4, PIN 3
4 – 20 mA Connector J4, PIN 4
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b.	 Select the Jumper J5 in P2P Mode.

Figure 4	 Jumper J5 Location

			 

P2P

MDROP

CAM16 J5

P2P

MDROP

CAM16 J5

CAM216 J5

MDROP

P2P

CAM216 J5

MDROP

P2P

c.	 For Analog mode, CAM16 – Connector J4, Pin 1 and 2 (CAM CARD 4 – 20 mA 
Output) should be connected to Pin 1 and Pin 2 (Analog Input 1) of Connector 
P1 of 320 B Board.

d.	 Ensure that all connections from step 5 are properly secured among CAM16, 
320B board and the HART Input signal. Then, tighten the screws and proceed 
to close the unit.

6.	 HART Digital Control (Multi-Drop)

a.	 Connect the HART Analog 4 – 20 mA input signal as follows:

Table 8.	 HART Control Types (3)

HART (+) Connector J4, PIN 3
HART (-) Connector J4, PIN 4

b.	 Select the Jumper J5 in Multi-Drop Mode.

Figure 5	 Jumper J5 in Multi-Drop Mode

				  

P2P

MDROP

CAM16 J5

P2P

MDROP

CAM16 J5

CAM216 J5

MDROP

P2P

CAM216 J5

MDROP

P2P

c.	 Do the necessary changes in Host. It is important to make sure that all devices 
to be connected in this mode have a different HART address. The HART 
polling address can be found under the HART device information for each 
device. Make sure that you connect one device at the time while changing the 
addresses to avoid having devices with the same address on the network.
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7.	 HART Digital Control (Wireless THUM) 
Refer to Section 12 for details about the THUM wiring and configuration.

2.2	 Installation of HART CAM16 in HQ-DCM33 Unit

1.	 Remove power from the device and open the top main cover to expose the internal 
electronics. Locate the main DCM33 Board.

2.	 Locate J2 connector on DCM33 board and J3 connector on CAM16. Connect the 
CAM16 on the J2 connector. Then, secure the CAM16 board using the 3 plastic screw 
holders onto the DCM33 board.

Figure 6	 J2 Connection for CAM16

	

3.	 Follow Step 4, 5 or 6 depending on your HART Network type:

Table 9.	 HART Control Types (4)

Control Type Step to Follow
HART – Analog Control (Point-to-Point) Step 4
HART – Digital Control (Multi-Drop) Step 5
HART – Digital Control (Wireless THUM) Step 6

4.	 HART Analog Control (Point-to-Point; Actuator Must be in Analog Control Mode)

a.	 Connect the HART Analog 4 – 20 mA input signal as follows:

Table 10.	 HART Control Types (2)

4 – 20 mA Connector J4, PIN 3
4 – 20 mA Connector J4, PIN 4
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b.	 Select the Jumper J5 in P2P Mode.

Figure 7	 Jumper J5 in P2P Mode

			 

J5

c.	 For Analog mode, CAM16 – Connector J4, Pin 1 and 2 (CAM CARD 4 – 20 mA 
Output) should be connected to Pin 1 and Pin 2 (Analog Input 1) of Connector 
P1 of 320 B Board.

d.	 Ensure that all connections from step 5 are properly secured among CAM16, 
320B board and the HART Input signal. Then, tighten the screws and proceed 
to close the unit.

5.	 HART Digital Control (Multi-Drop):

a.	 Connect the HART Analog 4–20 mA input signal as follows:

Figure 8	 Connection of CAM16 with 320B Board

	

Table 11.	 HART Control Types (6) 
HART (+) Connector J4, PIN 3
HART (-) Connector J4, PIN 4
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b.	 Select J5 Jumper in Multidrop Mode.

c.	 Do the necessary changes in Host. It is important to make sure that all devices 
to be connected in this mode have a different HART address. The HART 
polling address can be found under the HART device information for each 
device. Make sure that you connect one device at the time while changing the 
addresses to avoid having devices with the same address on the network.

6.	 HART Digital Control (Wireless THUM): 
Refer to Section 12 for details about the THUM wiring and configuration.

2.3	 Installation of HART CAM16 in MPA Unit

1.	 Remove power from the device and open the Local Display Module (LDM) by removing 
the 4 screws on each corner. Access the internal electronics and locate the MPA CPU on 
the back of the display. While opening the device, pay extra care to the connectors at 
back of the CPU.

Figure 9	 LDM Connectors

                    	

2.	 Locate the P2 connector on the MPA CPU and the 3 plastic holders:

Figure 10	 P2 Connector
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3.	 Connect CAM16 J3 into MPA CPU connector P2 and tighten the 3 plastic holders.

Figure 11	 CAM16 J3 Connection

                             	

4.	 Follow step 5 or 6 depending on your HART Network type:

Table 12.	 HART Control Types (7)

Control Type Step to Follow
HART – Analog Control (Point-to-Point) Not Available
HART – Digital Control (Multi-Drop) Step 5
HART – Digital Control (Wireless THUM) Step 6

5.	 HART Digital Control (Multi-Drop):

a.	 Locate the networking port wires (in the back of the MPA CPU) and connect 
the appropriate wires to the CAM16 I+ and I- for the network port to be used 
for communications. Once selected, open the front cover of the MPA and 
connect your HART input to the desired networking port.

Table 13.	 HART Control Types (8)

CAM16 J4 MPA TBM
O- 20
O+ 21
I- 22
I+ 23



CAM216/16 IOM 
Doc. Number: ECM-402-0116 January 2016, Rev. 1

13

Section 2: Installation of CAM16

Installation of CAM16

b.	 Connect J5 Jumper in Multidrop Mode.

NOTE:  

The network wires coming from the MPA TBM to the MPA CPU area may not be labeled, if so, 
verify that you are using the correct wires for the desired communication port.

6.	 HART Digital Control (Wireless THUM): 
Refer to Section 12  for details about the THUM wiring and configuration.

2.4	 Installation of HART CAM16 in EHO Unit

Steps for adding CAM16 (HART) Card in Smart EHO unit

1.	 Disconnect the actuator from the power source and open the Local Display Module 
(LDM) by removing the 4 bolts on each corner.

Figure 12	 LDM Cover Removal
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Figure 13	 Side View of LDM Cover Removal

                    	

2.	 Separate the LDM assembly by disconnecting all the wire harnesses. Take care not to 
break any of the connectors.

Figure 14	 LDM Wire Connectors
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3.	 Separate the Field Board from the LDM assembly by removing the screws.

Figure 15	 LDM Board Screws

                    	

Figure 16	 LDM Board Interior
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4.	 Locate the P2 connector on the EHO CPU and the three plastic holders. Connect 
CAM16 J3 into EHO CPU P2 while making sure  to properly secure it using the 3 plastic 
holders. Check the image below for HART CAM16 Board installation.

Figure 17	 CAM16 J3 P2 Connector

                    	

Figure 18	 HART CAM16 Field Board
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5.	 Once the CAM16 is installed on the EHO CPU Board, connect the custom cable  
(Part no. VA-ED-001-6238) to I (+), I (-),O (+) and O (-) respectively as per connection 
diagram given below:

Figure 19	 Custom Cable Connection

                    	

J5

Figure 20	 Connection Wiring Diagram
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Table 14.	 STC Pins

STC Pins STC Back Pins CAM card pins HART Connection
41 5 J4(0+) HART O+
42 2 J4(0-) HART O-
43 6 J4(I+) HART I+
44 3 J4(I-) HART I-

Figure 21	 CAM16 J3 STC Connection

                    	

6.	 To connect the other end of the wire harness to STC 
On the CAM16, locate connector J4 and make sure that it is securely connected to 
the inside of the actuator using a 6-wire connector. This connector provides the 
communication between the LDM and the STC on the EHO, if missing or not properly 
connected; you will not be able to establish communication to your device 
The wire harness fits into the 6-pin micro-fit connector on the inner side of the STC. 
Temporarily separate the STC from the EHO enclosure by removing 4 bolts, so that it 
will be easy to connect the wire harness. Plug the wire harness into the 6-pin housing 
connector on the STC's back side and reinstall the STC assembly.
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Figure 22	 CAM16 J3 Connection for EHO STC

                    	

Remove 
screws 

to access 
backside 

of STC

7.	 Reassemble the Field Board with connectors.

8.	 Reinstall the LDM assembly back to the EHO unit.

9.	 Now follow steps 10, 11 or 12 depending on your HART network type.

Table 15.	 HART Control Types (8)

Control Type Steps to Follow
HART - Analog Control (Point to Point) Step 10
HART - Digital Control (Multi Drop) Step 11
HART - Digital Control (Wireless THUM) Step12

10.	 HART – Analog Control (Point to Point; Actuator Must be in Analog Control Mode)

a.	 Connect the HART 4-20 mA signal to the STC Pin 43 and 44. The 4–20 mA 
output would be available at STC Pin 41 and 42. These output pins must be 
connected to the actuator’s analog input 1 STC Pin 25 and 26.

b.	 Connect Jumper J5 in P2P

Figure 23	 CAM16 J5 Jumper

                    	

J5
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11.	 HART – Digital Control (Multi-Drop)

Table 16.	 HART Control Types (9)

HART Connection Pins
HART (+) STC Pin 43
HART (-) STC Pin 44

a.	 It is important to make sure that all devices to be connected in this mode have 
a different information for each device. Make sure that you connect one device 
at a time while changing the addresses as to avoid having devices with the 
same address on the network.

b.	 Connect J5 Jumper in Multidrop Mode

Figure 24	 CAM16 J5 Configured for Multidrop Mode

                    	

P2P

MDROP

CAM16 J5

P2P

MDROP

CAM16 J5

CAM216 J5

MDROP

P2P

CAM216 J5

MDROP

P2P

12.	 HART – Digital Control (Wireless THUM) 
Refer to Section 12 for details about the THUM wiring and configuration.

13.	 Switch ON the power to the unit.

14.	 Through LDM Menu;

a.	 Set Control Mode(CO) to 7 (Network)

b.	 Set the Network Adapter Parameter (nA) to 9 (HART Block Mode) or 10 (HART 
Modulation Mode) (Refer LDM Flow document for navigation)

15.	 Save the settings
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Section 3:	Installation of CAM216
Emerson Process electric actuators equipped with HART CAM216 option require a main power 
source. This source will power the electric motor and all electronic controls including the 
CAM216. The CAM216 HART interface is powered directly from the device, and is not capable 
of communication when the actuator does not have power. Refer to the site planning guide 
for proper wire types, termination, length, and others into an Emerson Process Management 
electric actuator.

The CAM216 is supported by the TEC2000, TEC2 and Model 500 electric actuators equipped 
with Auxiliary Control Module (ACM) and proper wiring. For more information about installing 
the ACM, refer to TEC2000 Installation and Operation Manual E2K-405-0703.

Figure 25	 CAM216

                    	

3.1	 Installation of HART CAM216 in TEC2000 Unit

1.	 Remove power from the device and open the frontal side chamber on the TEC2000 by 
removing the 4 bolts located on each corner. After removing the bolts, pull the side 
chamber outwards to gain access to the ACM. If it is difficult to remove, you might 
assist the removal of the chamber by driving in the removed bolts on the threaded 
corner openings to help the cover “push” itself out as you drive in the bolts.
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Figure 26	 CAM216 in TEC2000

                                                 	

Figure 27	 Front View of TEC2000

                                         	

2.	 Once the chamber is open, locate the ACM inside it and verify that connections P12 
and P8 or any other connections (if equipped) were not accidentally disconnected  in 
the process. Locate connector P17 and the openings to mount the CAM216 holders. 
Mount the CAM216 into the ACM using the 4 holders in the corners making sure 
that connector J7 on CAM216 is properly aligned to P17 on the ACM then proceed to 
tighten the CAM216 holders.

Figure 28	 CAM216 in the ACM
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3.	 On the CAM216, locate connector J6 and make sure that it is securely connected 
to the inside of the actuator using a 6-wire connector. This connector provides the 
communication between the ACM and the STC on the TEC2000, if missing or not 
properly connected, you will not be able to establish communication to your device.

Figure 29	 TEC2000 Sealed Terminal Chamber Pin Diagram

                               	

4 - 20 mA Input
with HART 

[ 43 ( HART - ) 
and 44 (HART + ) ]

Connect pin 25 
to pin 41

Connect pin 26 
to pin 42

4.	 Now that the CAM216 is in place, close and bolt down the ACM chamber. Then, locate 
the Separate Terminal Chamber (STC) on the back of the TEC2000. Then, follow step 5, 
6 or 7 depending on your HART Network type:

Table 17.	 HART Control Types (9)

Control Type Step to Follow
HART – Analog Control (Point-to-Point) Step 5
HART – Digital Control (Multi-Drop) Step 6
HART – Digital Control (Wireless THUM) Step 7

5.	 HART Analog Control (Point-to-Point; Actuator Must be in Analog Control Mode):

a.	 Connect the HART 4-20 mA signal to the STC Pin 43 and 44. The 4–20 mA 
output would be available at STC Pin 41 and 42. These output pins must be 
connected to the Actuator’s Analog Input 1 STC Pin 25 and 26.
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b.	 Connect J5 Jumper in P2P Mode.

Figure 30	 J5 Jumper in P2P Mode

            		                     	

P2P

MDROP

CAM16 J5

P2P

MDROP

CAM16 J5

CAM216 J5

MDROP

P2P

CAM216 J5

MDROP

P2P

6.	 HART – Digital Control (Multi-Drop; Actuator Must be in Network Control Mode): 
It is important to make sure that all devices to be connected in this mode have a 
different HART address. The HART polling address can be found under the HART device 
information for each device. Make sure that you connect one device at the time while 
changing the addresses as to avoid having devices with the same address on the 
network. Connect J5 Jumper in Multidrop Mode. 
 
Connection shall be as follows –

Table 18.	 HART Control Types (10) 
HART(+) STC Pin 43
HART(-) STC Pin 44

7.	 HART Digital Control (Wireless THUM; Actuator Must be in Network Control Mode): 
Refer to Section 12  for details about the THUM wiring and configuration.

8.	 Modbus Channel on CAM216: 
CAM216 also supports one Modbus channel. Please refer to TEC2000 STC Image and 
Pin 39 and 40 would be used for RS 485 connection.

Table 19.	 HART Control Types (11) 
MODBUS(+) STC Pin 40
MODBUS(-) STC Pin 39
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Section 4:	HART Quick Setup and  
     Actuator Options
The Emerson Process Management Electric Actuators must have mechanical valve travel and 
torque switches set first. Refer to Manual E796 to perform these adjustments.

4.1	 M2CP-320B Quick Setup Instructions

The M2CP-320B is factory configured as specified by the customer purchase order. If field setup 
changes are required, follow the setup instructions as mentioned below.

1.	 Entering Setup Mode: 
Locate DIP switches SW1, SW2, and SW3 (Execute button) on the DCM 320B 
board and make a note of the original configuration of the switches before making 
modifications. SW1 selects mode, SW2 selects respective setup parameters and SW3 
sends the changed configuration. Place the selector switch in the OFF position and 
select desired setup mode by setting SW2. Please refer to Controlinc Quick Startup 
Guide for DCM320B. If done correctly, you will see a rapid flashing  
CPU GOOD indicator.

2.	 Valve Control Mode: 
Enter the following configuration on SW1 and SW2 to change the Valve  
Control settings: 
Set both SW1 and SW2 switches as indicated below and press the execute button to 
store the setup parameter to non-volatile memory.

Figure 31	 Valve Control Mode Switch Settings

                               	

3.	 Exiting Setup Mode: 
To exit Setup mode, place SW1 and SW2 back to the original configuration and press 
the execute button. If successful, CPU GOOD will return to a slow and steady flashing.
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4.2	 HQ-DCM33 Quick Setup Instructions

The DCM33 is factory configured as specified by the customer purchase order. If field setup 
changes are required, follow the setup instructions as mentioned below.

1.	 Entering Setup Mode: 
Locate DIP switches SW1, SW2, and SW3 (Execute button) on the DCM33 Board and 
make a note of the original configuration of the switches before making modifications. 
SW1 selects mode, SW2 selects respective setup parameters and SW3 sends the 
changed configuration. Place selector switch in the OFF position and select desired 
setup mode by setting SW1 and SW2. Please refer Controlinc Quick Startup Guide for 
DCM33. If done correctly, you will see a rapid flashing CPU GOOD indicator.

2.	 Valve Control Mode:

—— Enter the following configuration on SW1 to change the valve control settings:

Figure 32	 Valve Control Switch Settings

                               	

—— For Network Control Mode (Host), set all switches to the OFF position as 
shown below:

Figure 33	 Network Control Mode Switch Settings

                               	

—— For Analog Input Control (4-20mA), set switches as shown below:

Figure 34	 Analog Input Control Switch Settings

                               	

—— When both SW1 and SW2 switches are set, press the execute button to store 
the setup parameter to non-volatile memory.

3.	 Exiting Setup Mode: 
To exit Setup mode, place SW1 and SW2 back to the original configuration and press 
the execute button. If successful, CPU GOOD will return to a slow and steady flashing.

4.3	 MPA Quick Setup Instructions

The MPA is factory configured as specified by the customer purchase order. If field setup 
changes are required, follow the setup instructions as mentioned below. Operating modes for 
the MPA may be setup by using the MPA CONFIG Software or by navigating on the LDM  
setup menu.
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1.	 Setup Mode Display Sequence: 
The three (3) amber LED’s for the LOR section flash to indicate Setup Mode. When 
in setup mode, the user must enter the REMOTE(NEXT) or LOCAL(BACK) within 120 
seconds or the display will revert back to the normal display mode. 
 
Setup data may be changed by using the UP and Down entries of the Control Knob.  
The UP and Down entries are active only after a valid pass-code is entered and the 
Selector Switch is in the STOP position. The default pass-code is P1 00 and P2 00. Once 
the correct pass code is entered and accepted at the actuator controls, the user will 
then be able to advance through the displays shown in the Main Menu table:

Table 20.	 Main Menu Table  

Menu Parameter Value Units Default

C0 Control Mode 0-1
0=Discrete 
1=Network

1

—— The table on the following page shows the sequence of the setup menus. It 
also shows the selections, units, and defaults. Each time the REMOTE (NEXT) 
selector knob is selected, the display advances to the next menu item. Each 
time the LOCAL (BACK) selector knob is selected, the display backs up to the 
previous menu item. The UP and DOWN control knob is used to increment or 
decrement the value shown in the table. 
 
Once in setup mode, navigate through the menus and verify that the proper 
setup is configured.

NOTE:  

RDM port configuration is fixed at 9600 Baud rate, None Parity Bit, 8 Data Bits, 1 Stop Bit  
and Network Address 254 and may not be changed by the user. Only the network port  
configuration may be changed. The address programmed for the network port will be  
accepted by the RDM port in addition to address 254.

4.4	 TEC2000, TEC2 and Model 500 Quick Setup 
Instructions

The TEC2000 is factory configured as specified by the customer purchase order. If field 
setup or factory configuration changes are required, contact your nearest Emerson Process 
Management representative for assistance. Only authorized Emerson Process Management 
Representative or trusted partner should make modification to factory settings. Operating 
modes for the TEC2000 may be reviewed by using DCMlink software or by navigating on the 
LDM Setup menu. As a minimum, the Network Adapter must be set for HART (On/Off) (Block) 
mode or the HART Positioner (Analog) (Modulating) mode. Valve Position Feedback must be 
calibrated for either device type by stroking the valve from the CLOSE to OPEN and OPEN to 
CLOSE limits with selector switch in the LOCAL mode.

You can set or verify the following information by setting up DCMlink on the device or by 
navigating on the LDM Setup menu.

Setup through LDM:

First, locate the Selector knob (Local, off, remote) and the control knob (Open, Close) on the 
front of the LDM. You will use the Control knob to answer “yes” or “no” at prompts on screen 
during setup. You will use the selector knob to navigate “back” or “next” through the menu 
options.
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1.	 Place the Selector Knob in OFF, then; move the control knob in the following order 
within 3 seconds: open, close, open, close, open, and close. If done correctly, “Setup?” 
will appear on screen.

2.	 By Moving the Control Knob, navigate to Setup -> Display Unit Parameters -> Control 
Mode and verify that “Network” or “Analog” is selected as required. Select “Next” and 
verify that “Network Adapter” shows “HART Block” or “HART Modulation” mode.

3.	 Make sure the Network “Response Delay” parameter; set to 8 mSecs. 

4.	 Place the Selector Knob in BACK and wait until it reaches to “Setup?” then move the 
Control Knob to “NO” and you will be exited from the Setup Mode.
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Section 5:	Detailed Setup and Options
The actuator must be set up as defined in Section 4.4, prior to performing the following 
detailed setup.

5.1	 Restarting the Actuator

You can restart the Actuator by turning off and on the main power source. The process of 
restarting the actuator should be done cautiously because the CAM card is directly powered 
from the device and is not able to communicate when the actuator does not have power.

 WARNING: DO NOT RESTART AN ACTIVE ACTUATOR
Restarting the actuator may cause loss of control of the process.

5.1.1	 Restarting HART Interface

5.1.2	 When the HART Interface is restarted using Device Reset Option (Service Tool -> 
Maintenance -> Reset) 

5.2	 Write Lock

If the actuator is write protected, that means it will prevent any external change to the static 
or non-volatile data. It shall not be possible to remove write protect from Network (via DD or 
Application software). This is due to the security restrictions. To disable write protect, user 
must use the Actuator knobs / DIP switches. Please refer to Device Instruction Operation 
Manual to know about disabling the write protect.

5.3	 Simulate

CAM16/216 does not support simulation.

5.4	 Calibrating Travel

You must calibrate the actuator manually after the mechanical valve travel limits are set 
or changed. Calibration is required only one time after the travel limits are set or changed. 
Calibration parameters are stored in a non-volatile memory, which holds the variables when 
power is removed from the actuator.

5.4.1	 Calibration Procedure

1.	 Place the LOR selector switch to the “LOCAL/MANUAL” mode. 

2.	 Set travel limit switches as per the valve travel on which the actuator is attached. Refer 
to VALVE AUTOMATION Manual E796 for “Limit Switch Setting Instructions”. 

3.	 Stroke the valve fully CLOSED, OPEN, and CLOSED using the local push buttons. 

4.	 The actuator automatically calibrates the “Position Feedback” from 0 to 100% scale 
and makes this data available to the HART Interface. 

5.	 Place the LOR selector switch in the “Remote/Auto” mode to return control to the 
HART Interface. 
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NOTE:  

Calibration may be executed remotely by placing the selector switch in the REMOTE/AUTO 
mode and commanding the actuator to close and then open and then close. The actuator will 
automatically calibrate “Position Feedback” to the valve travel limits and make this information 
available to the HART Interface. Both methods of calibration will move the actuator to  
determine the end of travel points for the actuator. The actuator must move to each limit  
of travel (fully open and fully close) or else the calibration will not be completed. 

5.5	 Function Type

The function type is defined by the parameter Function Type and defines the type or mode of 
operation of the actuator. The two types allowed are BLOCK and MODULATING.

The Function Type – BLOCK is for on/off or Block type actuation of a valve. The Function Type – 
MODULATING is for Positioner or Modulation type of valve actuation.

5.6	 Actuator Command (On/Off)

The Actuator Command is only available when the actuator is configured for Block Mode (On/
Off). Actuator Command is used to command the actuator to the desired position of "Closed”, 
"Opened" or "Stop”. If the actuator is commanded to its "Open" or "Closed" position, it will 
remain in that position and will attempt to maintain that position except if something happens 
to the actuator to cause the position to change, for instance if someone would try to move the 
valve using the hand wheel. Once the actuator detects the position has changed, it will attempt 
to move the actuator back to its commanded position. If the Hand wheel position is desired, 
then the actuator must be placed in LOCAL/MANUAL.

If the actuator is given a "Stop" command, it will stop processing position data and will not 
command the actuator to any position and will not adjust except the current position change 
due to external influences. This command is used to manually position the actuator.

5.7	 Setpoint (Positioner)

The Setpoint Command is only available when the actuator is configured for Modulating Mode 
(Positioner). Setpoint is used to command the actuator to the desired position. The command 
is represented as a percentage of the full travel of the device. The actuator will remain in the 
commanded position (+/- Dead band) and will attempt to maintain that position except when 
something happens to the actuator to cause the position to change. For instance, if someone 
would try to move the valve using the Hand wheel, the position may change. Once the actuator 
detects the position has changed, it will attempt to move the actuator back to its commanded 
position. To move the actuator via another means, the actuator selector switch must be placed 
in the Local/Manual or OFF position.

5.7.1	 Dead band 
An integral part of the Setpoint command is Dead band or Position Control Bandwidth. 
Dead band is handled internally by the DCM and is a basic function of actuator internal 
inertia, load inertia and the actuator motor starter. The Position Control Bandwidth 
can be set in the DCM with value between 0.1% to 5.0%. Under most circumstances, 
the actuator will require one of two options to use a Position Control Bandwidth less 
than the default value of 1.0%. Both of these are additions to the electro-mechanical 
reversing contactor.  
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The first option is the solid-state reversing starter, which will allow a higher degree of 
accuracy of control, and as such, a smaller degree of Dead band. The second option is 
a Variable Frequency Controller, which is used for the highest degree of accuracy and 
the smallest degree of Dead band. The DCM also has a setup for these optional motor 
starter types and must be set up for them. For more information, please refer to the 
Valve Automation Controlinc Quick Startup Guide.

5.8	 ESD Command

This command is available with the device is in both Modulating and Block Modes. This 
command overrides all other commands and forces the actuator to a pre-selected position, 
CLOSE, OPEN, or STAY-PUT. These pre-selected positions are options that can be set on the 
DCM. If the DCM has ESD set and the actuator is commanded into ESD, the actuator will not 
respond to any other movement commands until the ESD command is removed.

NOTE:  

“ESD on lost communication” feature is not available when using HART CAM16/216 since the 
HART board maintains power even after it is cut off from the host and polling of the  
actuator continues.

5.9	 Input Output Channel Listing

Table 21.	 Input Output Channel Table 

Parameters MPA
M2CP 
320B

HQDCM33 TEC2000
TEC2 / 
Model 
500

EHO

Analog Input 1 N/A Yes Yes Yes Yes Yes
Analog Input 2 N/A Yes N/A Yes Yes Yes
Analog Output 1 N/A Yes Yes Yes Yes Yes
Analog Output 2 N/A N/A N/A N/A 1 Yes 2 Yes
Discrete Input 1 N/A Yes Yes Yes Yes Yes
Discrete Input 2 N/A Yes Yes Yes Yes Yes
Discrete Input 3 N/A N/A N/A Yes Yes Yes
Discrete Input 4 N/A N/A N/A Yes Yes Yes
Discrete Input 5 N/A N/A N/A Yes Yes Yes
Discrete Input 6 N/A N/A N/A Yes Yes Yes
Relay 1 N/A Yes N/A Yes Yes Yes
Relay 2 N/A Yes N/A Yes Yes Yes
Relay 3 N/A N/A N/A Yes Yes Yes
Relay 4 N/A N/A N/A Yes Yes Yes
Relay 5 N/A Yes N/A Yes Yes Yes

NOTE:  

- For HART CAM Card, Analog Output 2 is not applicable. The reason for this is, CAM Boards can 
only be mounted on the Controlinc ACM. The Controlinc ACM supports only 2 Analog Inputs 
and 1 Analog Output 
- Unlike TEC2000, TEC2 has a separate ACM called TEC2 ACM and it supports 2 Analog Inputs 
and 2 Analog Outputs as well



January 2016, Rev. 1
CAM216/16 IOM 

Doc. Number: ECM-402-0116

32

Section 5: Detailed Setup and Options

Detailed Setup and Options

5.10	 Actuator Options

The actuator may or may not contain any one or all of the following options:

•	 Phase Monitor – Phase monitors are not required for actuators with single-phase 
motors and may not be installed in some actuators with three-phase power. If this 
option is not installed, then the “Phase Monitor Alarm” of the “Actuator Status” will be 
inactive. As such, the Phase Monitor alarm will always be “Zero” or “Off”.

•	 Analog Torque Transducer – If this option is not installed in the actuator, the “Torque” 
analog channel is not available. The “Open Torque Alarm” and “Close Torque Alarm” 
are always active from the torque limit switches.

•	 Analog Auxiliary Output 1 – If this option is not installed, then “Analog Auxiliary Output 
1” is not available. The actuator must have the optional 320B-2 module installed to 
make this option available.

•	 Torque Parameter - If the optional transducer is installed, it will provide the 
instantaneous torque being generated by the actuator to the valve stem. The torque 
value is expressed as a percentage of full scale of the rated torque of the actuator from 
– 0% (normally closing) to 100% (normally opening). For TEC2, Model 500 and EHO 
electric actuators, torque is a standard feature. For M2CP, it is optional and must be 
specified when placing an order. For HQ actuator, torque options are not available.

5.11	 Alarms and Status

There are no dedicated channels for Status and Read back; however, alarms can be monitored 
from the DD. The following table depicts the applicability of each Field Device Alarm, with 
respect to Actuators. These Alarms are mapped to Command #48 Response Bytes.

Table 22.	 Alarm Types (1) 

Field Device 
Alarms

Actuators

MPA
M2CP 
320B

HQDCM33 TEC2000
TEC2 / 
Model 
500

EHO

Actuator Fail Alarm Yes Yes N/A Yes Yes Yes
Phase Monitor Alarm Yes Yes N/A Yes Yes Yes
Motor Thermal 
Alarm

Yes Yes N/A Yes Yes Yes

Power Monitor 
Alarm

Yes Yes N/A Yes Yes Yes

Moving Wrong 
Direction

Yes N/A N/A N/A N/A N/A

CCM Failure Alarm N/A N/A N/A Yes Yes N/A
LDM Failure Alarm N/A N/A N/A Yes Yes Yes
APD Failure Alarm N/A N/A N/A Yes Yes N/A
RDM1 Failure Alarm N/A N/A N/A Yes Yes Yes
RDM2 Failure Alarm N/A N/A N/A Yes Yes Yes
Hydraulic Power 
Unit Fault Alarm

N/A N/A N/A N/A N/A Yes

Solenoid Valve Fault 
Alarm

N/A N/A N/A N/A N/A Yes
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Table 23.	 Alarm Types (2) 

Field Device 
Alarms

Actuators

MPA
M2CP 
320B

HQDCM33 TEC2000
TEC2 / 
Model 
500

EHO

Pressure Transmitter 
Fault Alarm

N/A N/A N/A N/A N/A Yes

Encoder Fault Alarm N/A N/A N/A N/A N/A Yes
Communication 
Failed Alarm

Yes Yes Yes Yes Yes Yes

Electronics Fault 
Alarm

N/A N/A N/A Yes Yes N/A

Initialization Failed 
Alarm

Yes Yes Yes Yes Yes Yes

Compatibility Error Yes Yes Yes Yes Yes Yes
Over Pressure in Mid 
Travel Alarm

N/A N/A N/A N/A N/A Yes

Analog Input 1 Out 
Of Range

N/A Yes Yes Yes Yes Yes

Analog Input 2 Out 
Of Range

N/A Yes N/A Yes Yes N/A

Close Torque Alarm N/A Yes Yes Yes Yes Yes
Open Torque Alarm N/A Yes Yes Yes Yes Yes
Over Torque Alarm Yes N/A N/A Yes Yes Yes
Overshoot Alarm Yes N/A N/A N/A N/A N/A
Stop between Ports 
Alarm

Yes N/A N/A N/A N/A N/A

Hardwired  
ESD Alarm

Yes Yes Yes Yes Yes Yes

Host Command  
ESD Alarm

Yes Yes Yes Yes Yes Yes

Lost Analog  
Input 1 Alarm

N/A N/A N/A Yes Yes Yes

Lost Analog  
Input 2 Alarm

N/A N/A N/A Yes Yes N/A

Backup Power Alarm N/A N/A Yes N/A N/A N/A
Valve Stall Alarm Yes Yes Yes Yes Yes Yes
Partial Stroke Test 
Fail Alarm

N/A N/A N/A N/A N/A Yes
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Table 24.	 HART Specific Alarms 

Field Device 
Alarms

Actuators

MPA
M2CP 
320B

HQDCM33 TEC2000
TEC2 / 
Model 
500

EHO

Primary Variable Out 
of Limit

Yes Yes Yes Yes Yes Yes

Non-Primary 
Variable Out of Limit

Yes Yes Yes Yes Yes Yes

Loop Current 
Saturated

Yes Yes Yes Yes Yes Yes

Loop Current Fixed Yes Yes Yes Yes Yes Yes
More Status 
Available 

Yes Yes Yes Yes Yes Yes

Cold Start Yes Yes Yes Yes Yes Yes
Configuration 
Changed

Yes Yes Yes Yes Yes Yes

Device Malfunction Yes Yes Yes Yes Yes Yes
Maintenance 
Required  

Yes Yes Yes Yes Yes Yes

Device Variable Alert Yes Yes Yes Yes Yes Yes
Out Of Specification Yes Yes Yes Yes Yes Yes
Function Check Yes Yes Yes Yes Yes Yes
Device 
Configuration 
Locked

Yes Yes Yes Yes Yes Yes

Electronic Defect Yes Yes Yes Yes Yes Yes
Power Supply 
Condition Out of 
Range

Yes Yes Yes Yes Yes Yes

Non Volatile 
Memory Defect

Yes Yes Yes Yes Yes Yes

•	 Actuator Fail Alarm - This alarm generates due to failure in internal self-test of the 
actuator.

•	 Power Monitor Alarm - This alarm indicates a device failure due to loss of control 
voltage internal to the actuator (control voltage is associated with either fuze F1 or F2).

•	 Motor Thermal Alarm - This alarm indicates a device failure because the motor 
control circuit is disabled due to motor overheating or motor overload relay  
(if equipped) has tripped.

•	 Phase Monitor Alarm - This alarm indicates a device failure because the optional 
phase monitor, if installed, indicates a loss of one-phase or reversed-phase rotation of 
incoming three-phase power.

•	 Moving Wrong Direction - This alarm indicates that the actuator was turning in the 
wrong direction.

•	 Communication Failed Alarm - This alarm indicates a device failure because 
communication between the HART Interface and actuator has failed or has an error 
due to data integrity.

•	 Electronic Failure Alarm - This alarm indicates the internal hardwired system failure of 
electronics.
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•	 Initialization Failed Alarm- This alarm indicates the HART cannot communicate with 
the actuator or the upload/download generates an error.

•	 Compatibility Error Alarm – This alarm indicates the Actuator model or the Firmware 
is not compatible with the HART CAM board.

•	 Over Pressure in Mid Travel Alarm - This alert indicates that the hydraulic pressure 
has exceeded the archived pressure value and Pressure value Tolerance level (%) in the 
open direction.

•	 Analog Input Out of Range Alarm - This alarm indicates that the analog input to the 
actuator is beyond the legal limits of the input channel.

•	 Overshoot Alarm - This condition is reported when the valve crossed the target port 
and the valve must go all the way around. After 3 retries, this alarm will be triggered 
indicating a maintenance issue.

•	 Stop Between Ports Alarm - This alarm indicates that the actuator has failed to move 
to the commanded port.

•	 CPU Reset Alarm - This alarm indicates that the CPU has reset due to the power cycle. 
Additionally, for TEC2 and EHO actuators, this alarm also indicates a request to restart 
the processor from host has been executed successfully.

NOTE:  

Values of Duty Cycle, Default Setpoint 2 and Analog Output 1 Source are not retained after 
power cycling. They will go back to the default value when actuator power is restored.

•	 Valve Drift Alarm - This Alarm indicates that the movement that has been detected 
was not initiated from the motor running.  

•	 Low Battery Alarm - This Alarm indicates that the actuator has detected a low charge 
voltage on the internal Super CAP/Battery.

•	 Limits Not Set Alarm - This alarm indicates that the Fully Open and Fully Close limits 
are not configured.

•	 Low Oil Level Alarm - This alarm indicates oil level in hydraulic tank is less. However, 
this alert does not prevent actuator operation. This Alarm is only for EHO.

•	 Inhibit Alarm - This alarm indicates that the actuator has been configured to use the 
discrete inputs as inhibits and one of them is currently active. When active, this alarm 
will inhibit Actuator from moving.

•	 CCM Failure Alarm - This alarm indicates that Central Control Module has detected an 
internal failure.

•	 LDM Failure Alarm - This alarm indicates that Local Display Module has detected an 
internal failure.

•	 APD Failure Alarm - This alarm indicates Absolute Position Detector failure.

•	 RDM1 Failure Alarm - This alarm indicates Remote Display 1 failure. Remote display 
has been enabled in the configuration and either the RDM is not present, or has 
communication errors.

•	 RDM2 Failure Alarm - This alarm indicates Remote Display 2 failure.  Remote display 
has been enabled in the configuration and either the RDM is not present, or has 
communication errors.

•	 Hydraulic Power Unit Fault Alarm - The alarm indicates the Hydraulic Power unit 
Failure. Triggered when the Motor ran for more than 4 seconds but hydraulic pressure 
has not increased.
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•	 Solenoid Valve Fault Alarm - This alarm indicates SOV failure.

•	 Pressure Transmitter Fault Alarm - The alarm indicates pressure transmitter failure.

•	 Encoder Fault Alarm - Encoder alarm indicates the position value is incorrect due to 
communication error in encoder circuit.

•	 Close Torque Switch Alarm - The alarm indicates that close torque limit has exceeded 
its value the last time the actuator attempted to move in the close direction.

•	 Open Torque Switch Alarm - The alarm indicates that open torque has exceeded the 
configured value in the open direction.

•	 Over Torque Switch Alarm - The alarm indicates that torque has exceeded the  
torque limit.

•	 Config Conflict Error Alarm - The alarm indicates that actuator has been incorrectly 
configured, or hardware sanity checks do not match the actuator configuration 
settings. Internal system corruption of Control board may occur.

•	 Invalid SOV configuration Alarm - This alarm indicates SOV configuration is incorrect 
during self-calibration.

•	 Accumulator Pre Charge Alarm - This alarm indicates that the accumulator nitrogen 
pre-charge is not within the set range.  

•	 Accumulator Charge Fault Alarm - This alarm indicates that the accumulator did not 
charge to the maximum pressure within the allowed charge time.  The electric motor 
has been stopped until another command is received.

•	 Lost COM1 Alarm - This alarm indicates that the Network Communications has failed.

•	 Lost COM2 Alarm - This alarm indicates that the Network Communications has failed.

•	 ESD from Lost COM - This alarm indicates that actuator has been configured to 
perform ESD action on Lost COM alarm and the alarm is active.

NOTE:  

Loss in communication on HART side does not disturb the communication on Modbus side as 
HART CAM card is integral part of actuator, hence this alarm will not be generated unless CAM 
card is removed from actuator.

•	 Hardwired ESD Alarm  - This alarm indicates that actuator has been configured to 
perform ESD action on Lost COM alarm and the alarm is active.

•	 Host Command ESD - This alarm indicates that the HOST has sent an ESD command to 
the actuator.

•	 Lost Analog Input 1 Alarm - This alarm is triggered when the Analog Input 1 signal is 
not present and the actuator is configured for analog control.

•	 Lost Analog Input 2 Alarm - This alarm is triggered when the Analog Input 2 signal is 
not present and the actuator is configured for analog control.

•	 Backup Power Alarm - This alarm indicates that the actuator has detected a low 
charge voltage on the internal Super CAP.

•	 Valve Stall Alarm - This alarm indicates that the actuator has stalled for more than 10 
seconds while moving to the commanded position.

•	 Partial Stroke Test Fail Alarm - This alarm is reported when the Partial Stroke Test was 
not successful.
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6.1	 Device Variables

This Field Device has nine (9) Device Variables. These variables can be selected against the 
HART primary variables: PV, SV, TV, and QV with some limitations.

Table 25.	 Device Variables Table 

Device Variable Code Device Variable Name Units
0 Setpoint %
1 Position %
2 Torque %
3 Analog Input 1 %
4 Analog Input 2 %
5 Analog Output 1 %
6 Analog Output 2 %
7 Hydraulic Pressure PSI (Pounds Per Square Inch)
8 Accumulator Pressure PSI (Pounds Per Square Inch)

6.2	 Dynamic Variables

Table 26.	 Dynamic Variables Table 

Sr. No. Dynamic Variable Default Assignment Valid Range
1 Primary Variable 0: Setpoint 0: Setpoint

2 Secondary Variable 1: Position
0: Setpoint
1: Position

3 Tertiary Variable 2: Torque

2: Torque
3: Analog Input 1
4: Analog Input 2
5: Analog Output 1
6: Analog Output 2
7: Hydraulic Pressure
8: Accumulator Pressure

4 Quaternary Variable 3: Analog Input 1

2: Torque
3: Analog Input 1
4: Analog Input 2
5: Analog Output 1
6: Analog Output 2
7: Hydraulic Pressure
8: Accumulator Pressure
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7.1	 Device Status

Bit 7 (“Device Malfunction”): This bit shall be set when any status Bit mapped to NE107 
Category: Failure is set.

Bit 4 (“More Status Available”) : This bit shall be set whenever any bit in the Additional Device 
Status Bytes is set, in other words, whenever any additional status information is available. 
Command #48 would be used to read the Additional Status Info.

7.2	 Additional Device Status

Command #48 returns 10 bytes of data, with the following status:

Table 27.	 Device Status Alarms (1) 

Byte Bit Meaning
0 7   (0x80) APD Failure Alarm

6   (0x40) LDM Failure Alarm
5   (0x20) CCM Failure Alarm
4   (0x10) Moving Wrong Direction
3   (0x08) Power Monitor Alarm
2   (0x04) Motor Thermal Alarm
1   (0x02) Phase Monitor Alarm
0   (0x01) Actuator Fail Alarm

1 7   (0x80) Electronic Failure
6   (0x40) Communication Failed Alarm
5   (0x20) Encoder Fault Alarm
4   (0x10) Pressure Transmitter Fault Alarm
3   (0x08) Solenoid Valve Fault Alarm
2   (0x04) Hydraulic Power Unit Fault Alarm
1   (0x02) RDM2 Failure Alarm
0   (0x01) RDM1 Failure Alarm

2 7   (0x80) Overshoot Alarm1
6   (0x40) Over Torque
5   (0x20) Open Torque
4   (0x10) Close Torque
3   (0x08) AI-2 Out of Range.
2   (0x04) AI-1 Out of Range
1   (0x02) Over Pressure in Mid Travel Alarm.
0   (0x01) Initialization Failed Alarm

3 7   (0x80) Accumulator Pre-Charge Alarm
6   (0x40) Limits Not Set Alarm
5   (0x20) Low Battery Alarm
4   (0x10) Valve Drift Alarm
3   (0x08) Invalid SOV configuration Alarm
2   (0x04) Config Conflict Error
1   (0x02) CPU Has Reset
0   (0x01) Stop Between Ports Alarm1
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Table 28.	 Device Status Alarms (2) 

Byte Bit Meaning
4 7   (0x80) Reserved for Future Use

6   (0x40) Lost COM2 Alarm
5   (0x20) Lost COM1 Alarm
4   (0x10) Open Inhibit Alarm
3   (0x08) Close Inhibit Alarm
2   (0x04) Low Oil Level Alarm
1   (0x02) Accumulator Charge Fault Alarm

0   (0x01) Compatibility Error

5 7   (0x80) Partial Stroke Test Fail Alarm
6   (0x40) Valve Stall Alarm
5   (0x20) Backup Power Alarm
4   (0x10) Lost Analog Input 2
3   (0x08) Lost Analog Input 1
2   (0x04) Host Command ESD
1   (0x02) Hardwired ESD Alarm
0   (0x01) Reserved for future use

6 7   (0x80) Not used
6   (0x40) Not used
5   (0x20) Function Check
4   (0x10) Out Of Specification
3   (0x08) Failure
2   (0x04) Not Applicable
1   (0x02) Device Variable
0   (0x01) Maintenance Required

7 0 – 7 Operating Mode
8 7   (0x80) Device Configuration Locked

6   (0x40) Electronic Defect
5   (0x20) Not Applicable
4   (0x10) Power Supply Conditions Out-of-Range
3   (0x08) Not Applicable
2   (0x04) Not Applicable
1   (0x02) Non-volatile Memory Defect
0   (0x01) Not Applicable

9 7   (0x80) Not used
6   (0x40) Not used
5   (0x20) Not used
4   (0x10) Not used
3   (0x08) Not used
2   (0x04) Not Applicable
1   (0x02) Not Applicable
0   (0x01) Status Simulation Active
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8.1	 Universal Commands

Device supports following Universal Commands –

Table 29.	 Universal Commands Table

Command Description
0 Read Unique Identifier
1 Read Primary Variable
2 Read Loop Current And Percent Of Range
3 Read Dynamic Variables And Loop Current
6 Write Polling Address
7 Read Loop Configuration
8 Read Dynamic Variable Classifications
9 Read Device Variables with Status
11 Read Unique Identifier Associated With Tag
12 Read Message
13 Read Tag, Descriptor, Date
14 Read Primary Variable Transducer Information
15 Read Device Information
16 Read Final Assembly Number
17 Write Message
18 Write  Tag, Descriptor, Date
19 Write Final Assembly Number
20 Read Long Tag
21 Read Unique Identifier Associated With Long Tag
22 Write Long Tag
38 Reset Configuration Changed Flag
48 Read Additional Device Status

Command #3 returns PV, SV, TV and QV for a total of 24 bytes of response data.

Command #48 returns 10 bytes of Additional Device Status.
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8.2	 Common Practice Commands

Device supports following Common Practice Commands –

Table 30.	 Common Practice Commands Table 

Command Description
33 Read Device Variable
34 Write Primary Variable Damping Value
42 Perform Device Reset
49 Write Primary Variable Transducer Serial Number
50 Read Dynamic Variable Assignments
51 Write Dynamic Variable Assignments
54 Read Device Variable Information
56 Write Device Variable Transducer Serial Number
59 Write Number of Response Preambles
71 Lock Device
72 Squawk
76 Read Lock Device State
89 Set Real-Time Clock
90 Read Real-Time Clock
95 Read Device Communications Statistics
103 Write Burst Period
104 Write Burst Trigger
105 Read Burst Mode Configuration
107 Write Burst Device Variable
108 Write Burst Mode Command Number
109 Burst Mode Control
523 Read Condensed Status Mapping Array
524 Write Condensed Status Mapping
525 Reset Condensed Status Map
526 Write Status Simulation Mode
527 Simulation Status Bit
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8.3	 Device Specific Commands

Table 31.	 Device Specific Commands Table (1) 

Command Description
129 Default User NV Parameters
130 Write Device Variable (MANUAL)
131 Enable Write Protect Mode
132 Enable/Disable S/W Simulation of Alarms
133 Write ESD Delay
134 Write Valve Stall Delay Time
135 Enable/Disable PST 
136 Write Analog Control Source
137 Write Maximum Torque
138 Write Stroke Time
139 Write Language Selection
140 Enable/Disable Accumulator
141 Configure Valve Control Mode
142 Write Maximum Hydraulic Circuit Pressure
143 Write Maximum Self Calibration Pressure
144 Write Self Calibration Stroke Count Range
145 Write Pressure Unit 
146 Write Control Mode
147 Enable/Disable RDMs
148 Write Control Parameter 1
149 Write Control Parameter 2
150 Write Modulation Parameters
151 Configure Analog Input Alarms
152 Write Actuator Command (MANUAL)
153 Write Host Command ESD (MANUAL)
154 Enter Into Setup Mode
155 Write Limit Switch Trigger Point
156 Write Discrete Input Configuration
157 Write Relay Configuration
158 Write Open Speed Control Parameters
159 Write Custom Characterization Type
160 Write Target Travel ( Indices [0] – [49] )
161 Write Port Information
162 Enable/Disable ESD and Configure Action
163 Write ESD Overrides Parameter
164 Write Default Setpoints
165 Write Bluetooth Parameters
167 Write Configuration Commands
168 Write Torque Limits
169 Write MPA Port Calibration Data
171 Read Software Version ID
172 Read Compatibility Number
173 Read Alarms Simulation (Software) Status
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Table 32.	 Device Specific Commands Table (2) 

Command Description
174 Read Field Diagnostic Code
175 Read Alarm – Torque Out of Range
176 Read ESD Delay
177 Read Valve Stall Delay Time
178 Read PST Status
179 Read Analog Control Source
180 Read Maximum Torque
181 Read Stroke Time
182 Read Language Selection
183 Read Prognostics
184 Read Accumulator Status
185 Read Self Calibration Status
186 Read Maximum Hydraulic Circuit Pressure
187 Read Maximum Self Calibration Pressure
188 Read Self Calibration Stroke Count Range
189 Read Actuator Fully Open Time
190 Read Actuator Fully Close Time
191 Read Pressure Unit
192 Read Control Mode
193 Read RDM status
194 Read Control Parameter 1
195 Read Control Parameter 2
196 Read Modulation Parameters
197 Read Analog Parameters
198 Read Factory Hardware Parameters
199 Exit from Setup Mode
200 Read Actuator Command Status
201 Read Host Command ESD Status
202 Read HART Function Type
203 Read Actuator Mode
204 Read Firmware Date
205 Read Limit Switch Status
206 Read Limit Switch Trigger Points
207 Read Discrete Input Status
208 Read Discrete Input Configuration
209 Read Relay Status
210 Read Relay Configuration
211 Read Speed Control Parameter
212 Read Open Torque Profile ( Indices [0] – [50] )
213 Read Open Torque Profile ( Indices [51] – [100] )
214 Read Close Torque Profile ( Indices [0] – [50] )
215 Read Close Torque Profile ( Indices [51] – [100] )
216 Read Firmware Revision Numbers
217 Read Custom Characterization Type
218 Read Target Travel ( Indices [0] – [49] )
219 Read Port Information
220 Read ESD Parameters
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Table 33.	 Device Specific Commands Table (3) 

Command Description
221 Read ESD status and Action
222 Read ESD Overrides Parameter
223 Read PST Parameter
224 Read Operations Log
225 Read Default Setpoints
226 Read Bluetooth Parameters
227 Read Valve Control Mode
228 Read Factory Software Details
229 Read Torque Limits
230 Read MPA Port Calibration Data
231 Write Target Travel ( Indices [50] – [99] )
232 Enable / Disable Speed Control
233 Write Analog Output 1 Source
234 Write Analog Output 2 Source
235 Write Tag Information
236 Write Device Variable (AUTO)
237 Write Actuator Command (AUTO)
238 Host ESD / Clear ESD (AUTO)
239 Write Relay status (AUTO)
240 Write Relay status (MANUAL)
241 Read Model Number Details
242 Read Archived Open Torque Profile ( Indices [0] – [50] )
243 Read Archived Open Torque Profile ( Indices [51] – [100] )
244 Read Archived Close Torque Profile ( Indices [0] – [50] )
245 Read Archived Close Torque Profile ( Indices [51] – [100] )
246 Read Target Travel ( Indices [50] – [99] )
247 Write Close Speed Control Parameters
248 Write Anti Water Hammer Speed Control Parameters
249 Read Device Variables’ Alarm Control Code
250 Write Device Variables’ Alarm Control Code
251 Enable Disable CPU Reset Alarm Control Code
252 Read CPU Reset Alarm Control Code
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Section 9:	Device Descriptor (DD)
NOTE:  

 To download the DD for non-Emerson 3rd party host, please refer to the HART Foundation 
website: http://en.hartcomm.org/ and navigate to the Product Catalog.

To download the DD for Emerson hosts, please refer to: http://www.emersonprocess.com and 
do a search for “device install kit”, then follow the steps.

9.1	 Procedure for Adding DD to AMS and 375/475

Steps for installing stand-alone AMS:

Before we add DD to AMS, we need to configure HART Modem on AMS. (Ensure that HART 
Modem drivers are already installed before configuring Modems on AMS). Follow steps as 
stated below:

Network Configuration:

1.	 Open Start> All Programs> AMS Device Manager> Network Configuration

Figure 35	 Network Configuration Window

                               	

2.	 Click on Add and select Network Component Type: 
For HART device: HART Modem

Figure 36	 Select Network Component Type

                               	

http://en.hartcomm.org/
http://www.emersonprocess.com
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3.	 Click on Install and follow screen instructions.

Figure 37	 Adding the HART Modem (1)

                               	

Figure 38	 Adding the HART Modem (2)
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Figure 39	 Adding the HART Modem (3)

                               	

4.	 Select one COM Port from the list.

Figure 40	 Adding the HART Modem (4)
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Figure 41	 Adding the HART Modem (5)

                               	

When it is finished you will see a HART Modem added into the Network Configuration screen.

Figure 42	 HART Modem 1 Now Added
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Adding a new Device Descriptor (DD) in AMS:

1.	 Click on the start button and follow the sequence as shown below to open the Add 
Device Type Program in AMS Device Manager: 
Navigate to All programs -> AMS Device Manager -> Add device type

Figure 43	 Starting the AMS

                               	

2.	 A warning message will appear on the screen, click the option “OK” on the generated 
window.

Figure 44	 Add Device Type 

                               	

3.	 Click the option “Browse” as shown below and go to the location of the install kit.

Figure 45	 Browsing for Installation Folder
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Click OK and the DD will install. A progress bar will show for some period of time. 

4.	 When it is finished a message will pop up letting you know if DD is installed successfully 
or not.

Figure 46	 DD Installation Complete

                               	

5.	 To start the AMS process, click on the Start button and follow the sequence as  
shown below: 
Navigate to All Programs -> AMS Device Manager -> AMS Device Manager

Figure 47	 Starting AMS

                               	

6.	 Fill the user name as shown below. Password field will be left blank and Press OK.
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Figure 48	 User Name Window

                               	

7.	 Once the Login process is complete, the Device Explorer Screen will appear. On the 
Device Explorer Screen, Click on Device Connection View.

Figure 49	 Device Explorer Window
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8.	 Here, the Device will detect under HART Modem Tab as shown in below image:

Figure 50	 AMS Device Manager Detection

                               	

Troubleshooting AMS:

1.	 If AMS Device Manager does not show the live device on Device Connection View, 
Under the HART Modem Tab, then do the following:

—— Use the AMS Device Manager Configuration program to ensure that the 
modem has been assigned to a COM port.

—— Check that the modem is connected to the serial port corresponding to the 
COM port.

2.	 If AMS Device Manager gives error messages when it tries to populate the database   
with the new device, do the following: Run the AMS Device Manager Database  
Verify/ Repair (Start-All Programs- AMS Device Manager- Database Utilities-Database 
Verify Repair).

3.	 If New DD is added in AMS and it shows the old DD. First remove old DD available 
in database i.e. from C:\AMS\Devices\HART\06060, and then add new DD to AMS 
through add Device Type.

Adding a DD to the 375/475 (HandHeld)

1.	 Prerequisites:

—— 375/475 

—— DD Files

—— SD Card Reader 

—— Field Communicator Easy Upgrade Utility

2.	 DD will be added using the Easy Upgrade Programming Utility (in Start Menu)

3.	 Open Easy Upgrade Utility

4.	 375/475 can be connected to PC via IrDA, Bluetooth and Card Reader
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5.	 Select the connection type “Card Reader” and click connect.

Figure 51	 Connecting to the Card Reader

                               	

6.	 After a successful connection, in the left hand menu, click on Utilities and Select 
Import DDs from Local source.

Figure 52	 Selecting DDs from Local Source

                               	

7.	 Browse to where the 375/475 files (.hdd and .hhd) are located and click OK. You will 
get a message saying the import was successful.

Figure 53	 Browsing for the Files
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8.	 Now you have imported DD in your PC database.

9.	 Next step is to add this DD in your Card Reader.

10.	 Click on Upgrade and “More Options” in Upgrade System Card.

Figure 54	 Accessing More Options

                               	

Figure 55	 Options Window

                               	

11.	 The name of the DD and its details will be seen on DDs Tab. Expand HART database. 
Check the DD, you will get a pop message about the untested package is being 
created, click on “Yes”.
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Figure 56	 Untested Package Checking

                               	

12.	 Click on “Yes”, this will activate the button.

Figure 57	 Adding the Selected Item

                               	

13.	 Click on the button below, this will add DD to card reader and give a message; 
“Download is complete”.

Figure 58	 Completion Message

                               	

14.	 Now your DD is ready for use.
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9.2	 Overview Screen

Double-click the device icon; the AMS Device Manager, Window will open with the Overview 
menu displayed. The Overview screen contains three areas:

•	 The Status area

•	 The Primary Purpose Variables (or Variable)

•	 The Shortcuts area

Figure 59	 Overview Screen

                               	

9.3	 Device Status Images

•	 PlantWeb alerts

Figure 60	 PlantWeb Alert Displays
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•	 NAMUR NE107 based alerts

Figure 61	 NAMUR Alert Displays

                               	

9.4	 Device Information

To get the device information details, click on “Device Information” button (Overview Screen -> 
Device Information). Device Information Screen can be seen as follows:

Figure 62	 Device Information Window
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9.5	 Actuator Status

To get Actuator Information details click on “Actuator Status” button 
(Overview Screen -> Actuator Status). Actuator Status Screen can be seen as follows:

Figure 63	 Actuator Status Window

                               	

9.6	 Manual Setup

Manual Setup is used for configuring the device on a parameter basis.

Figure 64	 Manual Setup Window
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9.7	 Service Tools

1.	 Alerts 
This page will contain the active alerts 
If no alerts are active, then “No Active Alerts” image will be displayed.

Figure 65	 Active Alerts Window

                               	

2.	 Variables 
This section contains all the measurements or calculated values a device is capable of 
displaying throughout the user interface.

Figure 66	 Variables Window
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3.	 Trends 
This menu displays the charts and graphs with charts updating in real time.

Figure 67	 Trends Window

                               	

4.	 Maintenance 
This menu is used for common maintenance tasks.

Figure 68	 Maintenance Tasks Window
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9.8	 Methods

Methods, as used in HART terms, are a predetermined sequence of steps. These steps usually 
use a structured programming language and an interface definition. Methods can be used for 
a variety of functions including changing the mode and configuring the actuator . The hosting 
system and configuration software determines how these methods are handled and appear to 
the user.

Emerson Process Management electric actuators using HART CAM16/216 provide the  
following methods:

•	 Locate Device Method:  
It is used to identify the device in the field by showing pattern (0-0-0) on the device display.  
This method is applicable to MPA, TEC2000, TEC2, Model 500, and EHO.

•	 Change Mode Method: 
It allows the User to change the mode from Auto to Manual and vice-versa.

•	 Detailed Setup Method: 
It is used to configure the parameters of particular actuator.

•	 Target Travel Method: 
It can be used to configure Custom Characterization data points.

•	 Configuration Commands Method:  
It is used to configure the Configuration Commands parameter. Configuration Commands 
parameter is reserved for internal use only.

•	 Actuator Command Method:  
It can be used to control the actuator. The device will accept an Open, Close or Stop command 
and react accordingly. In case of MPA this method is called as Go to Next Port. This method is 
used to change the port of MPA actuator.

•	 Configure Polling Address Method: 
It allows the User to change the polling address of the device.

•	 Configure Advanced Broadcasting Method: 
It is used to configure three Burst Messages. This method will work only with those hosts who 
support advanced broadcasting.

•	 Write Protection Method: 
It allows the user to prevent changes to the device’s configuration. 

•	 Lock/Unlock Method:  
It allows a Master to give exclusive access of Device. It gives basically three options to lock the 
Device, Temporarily, Permanent, and Lock All to prevent the configurations that can be changed 
by another master. 

•	 Configure Setpoint Method: 
It allows the User to change the Setpoint of the device. This method is applicable only for MPA.

•	 Device Reset Method: 
It is used to reset the CAM card.
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10.1	 Stroking the Actuator

The actuator can be stroked (opened or closed) via the following techniques:

1.	 The hand wheel

2.	 The Local Push Buttons

3.	 Remotely using other Host, means such as Emerson’s DCMlink software 

10.1.1	 Using the Hand wheel (On/Off Function Type) 
To use the hand wheel to stroke the actuator while the selector switch is in Remote/
Auto position, the actuator must be commanded to its "Stop" state via the Actuator 
Command parameter. Normally, if the hand wheel is turned while the actuator is 
in control (Auto), and the movement causes the actuator to move more than the 
Deadband value from its commanded position, the actuator will compensate and 
attempt to move the actuator to its original commanded position, given that the 
Setpoint tracking option is selected. Using the "Stop" command will cause the actuator 
to stop processing position, thereby allowing the user to move the actuator with the 
hand wheel. Alternately, the LOR selector switch on the Local Control Panel can be 
moved to the “Local/Manual” or “OFF” position. The actuator electronics no longer has 
control of the actuator. It may then be moved using the Hand wheel.

NOTE:  

If the selector switch is in the Remote/Auto position and the Actuator Command is changed 
from "Stop", the actuator will immediately start moving to the commanded position depending 
on the control source (see the following sections).

1.	 Send a "Stop" command to the device Actuator Command parameter via the Discrete 
Output function block.

2.	 Move the actuator with the hand wheel.

3.	 Command the actuator to the desired position.

10.1.2	 Using the hand wheel (Positioning Function Type) 
To use the hand wheel to stroke the positioning actuator, the LOR selector switch 
should be moved to the “Local/Manual” or “OFF” position. If the hand wheel is turned 
while the actuator is in control, and the movement causes the actuator to exceed its 
Deadband value, the actuator will compensate and attempt to position the actuator to 
the originally commanded position. Placing the selector switch in the "Local/Manual” 
or “OFF” position will remove control from the actuator thereby allowing the user to 
move the actuator with the hand wheel.

NOTE:  

When the selector switch is moved to the "Remote/Auto" position, the actuator will  
immediately start moving the actuator to the commanded position depending on the  
control source (see the following sections).

10.1.3	 HART Interface Procedure 
When in remote mode (Auto) and the actuator is in a normal state, use SV (Setpoint) to 
command the actuator at desired position (0 to 100%), as long as the actuator is in the 
network control mode. 
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If the actuator is in analog control mode, you must use the configured Analog Input 
designated for control, and supply a signal of 4mA (0%) to close and 20mA (100%)  
to open. 
The M2CP actuator is not polarity sensitive for HART communications, but it is polarity 
sensitive for analog control purposes. Hence incorrect connection of the analog 
current cables will not allow a host to control the position of the actuator.

10.1.4	 Using the Local Control Station (if equipped) 
This section provides information as to the status indications received from the 
actuator when the actuator is equipped with a Local Control Station. 
When the Local Control Station is used, placing the LOR selector switch in the Local/
Manual position on the control panel will cause the "Local Override” status in the 
Actuator Status parameter to become true.

NOTE:  

The Local Control Station has priority over all control sources. When equipped and activated, 
no other control sources, including HART, can control the actuator until the Local Control Sta-
tion selector switch is returned to the “Remote/Auto” position, returning control to the other 
“electronic” control means. 
The Local Control Station has two sets of controls; 1) LOR selector switch with three (3)  
positions (Local/Manual, OFF, and Remote/Auto) and 2) Control push-buttons with three  
(3) buttons (Open, Stop, and Close).

Procedure is as follows – 

•	 Change the LOR selector switch position (mode) to (L) "Local/Manual".

•	 Move the actuator to the desired position using the Open, Stop, or Closed  
push buttons.

•	 When the actuator has moved to the desired position, return control to the HART 
Interface by placing the LOR in “Remote/Auto” position.

•	 At this point, the actuator will travel to its commanded position as specified via the 
Setpoint or Actuator Command parameter.

10.1.5	 Using Other Remote Control Means 
This section provides information on remote control of the actuator by means other 
than the HART Interface. The 320B controller within the actuator has two independent 
communication channels. One channel is used by the HART Interface and the other 
may be available to other configuration or remote control devices communicating on 
the other channel with another protocol. Such devices include Emerson’s DCMlink, a 
PC Windows-based software package. 
The 320B controller may also be configured to accept control from other means such 
as “discrete switch inputs” (pulse input mode) and “4-20mA control signal” (analog 
control mode). Refer to Emerson Process Management Electric Actuator Quick Startup 
Guide for wire connections and configuration setting of the 320B module.

When the actuator is configured to “Network” mode, it will be controlled by the digital 
command sent from the control system to the value of SV (set point), or when in block mode, 
to whichever open, close or stop command has been sent.

When the actuator is configured to “Analog Control” mode, the actuator will be controlled by 
the input connected to Analog Input 1 channel (4-20mA) to indicate 0-100% once it has  
been calibrated.
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Section 11:	 Installation of Optional THUM    		
		  Wireless Adapter

11.1	 Component Installation on TEC2000, TEC2 and 
Model 500

1.	 Disconnect the actuator from the power source and open the back cover to expose  
the STC.

2.	 Apply Teflon tape to both, the THUM and the reducer bushing threads to  
prevent galling.

3.	 Insert  the Wireless HART THUM and a 3/4 to 1/4 conduit reducer into one of the 
access ports in the actuator control housing. Then, tighten securely, making sure not 
to damage wires while turning.

NOTE:  

Reducer bushings used for non-hazardous locations installation only.

4.	 Once the THUM is securely installed, wire as shown below:

Table 34.	 TEC2000 and THUM Wiring Configuration 

TEC2000 STC THUM
9 Red
10 Black1200 Ohm Series Resistor
24 Green (Optional)
43 Yellow
44 White

Figure 69	 THUM mounted on TEC2000
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NOTE:  

Resistors and other required parts are available by ordering Part No. 87263 “Wireless HART 
THUM Kit”.

Figure 70	 THUM Wiring for TEC2000

                               	

5.	 Verify that all connections are secured and make sure the actuator is configured for 
“Network Mode” (Setpoint changes via THUM will not be accepted if not in proper 
mode), and then close the actuator.

11.1.1	 Wireless THUM with Intrinsically Safe Barrier on TEC2000

An Intrinsically Safe Barrier is available for use with the wireless THUM in oil and gas 
applications. The IS Barrier is wired between the THUM and the STC. The IS Barrier is installed 
in its own explosion proof case with sealed conduits above and below that separates the 
intrinsically safe THUM from the explosion proof TEC 2000. It is important that the seal in the 
conduits above and below the IS Barrier is not disturbed when servicing the unit. A wiring chart 
for this application is shown below that shows the connections between the THUM and IS 
Barrier and between the IS Barrier and the STC.
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Figure 71	 THUM Intrinsically Safe (IS) Barrier

                               	

Table 35.	 Intrinsically Safe Wiring Chart (1) 

IS Barrier
1 Red from STC
2 White from STC
GND Screw Black from STC
3 Red from THUM
4 Black and White from THUM
GND Screw Green and Yellow w/ 1200 ohm resistor

Table 36.	 Intrinsically Safe Wiring Chart (2) 

TEC2000 STC
9 Red
10 Black
41 250 ohm Resistor Side A
42 250 ohm Resistor Side B
43 White
44 Black
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Figure 72	 Intrinsically Safe Wiring Diagram

                               	

11.2	 Component Installation on M2CP

NOTE:  

The Local Control Station has priority over all control sources. When equipped and activated, 
no other control sources, including HART, can control the actuator until the Local Control  
Station selector switch is returned to the “Remote/Auto” position, returning control to the 
other “electronic” control means. 
The Local Control Station has two sets of controls; 1) LOR selector switch with three (3)  
positions (Local/Manual, OFF, and Remote/Auto) and 2) Control push-buttons with three  
(3) buttons (Open, Stop, and Close).

1.	 Disconnect the actuator from the power source

2.	 Open the cover to expose the internal electronics.

3.	 Unplug the 320A terminal interface board located inside the control housing by 
loosening screws (A) and (B) and carefully pulling the board forward to expose the 
mounting location for the CAM16 board (no wires need to be disconnected).

Figure 73	 320A Terminal Interface Board
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4.	 Insert the Wireless HART THUM and a 3/4 to 1/4 conduit reducer into one of the access 
ports in the actuator control housing. Then, tighten securely, making sure not to 
damage wires while turning.

Figure 74	 Wireless HART THUM Insertion

                               	

NOTE:  

Reducer bushings used for non-hazardous locations installation only. 
Teflon tape should be applied to both the THUM and reducer bushing threads to  
prevent galling.

5.	 Remove the male half of the Pluggable Terminal Block J4 on the CAM16 board.

6.	 Carefully insert the CAM16 board connector pins into the socket on the 320B board 
and press CAM16 board on to the (2) mounting legs.

7.	 Attach the wires from the Wireless HART THUM to the CAM16 J4  as shown in Table.

Table 37.	 THUM Wire Configuration  

CAM16 THUM
I- White
I+ Yellow

8.	 Reinsert the male half of the J4 connector into its base.

9.	 Reattach the 320A terminal interface board by plugging it into the connectors and 
retighten screw.

10.	 Connect the HART Wireless THUM GREEN wire to terminal #X2 on the 320B terminal  
board (Optional).

11.	 Connect the Wireless THUM to 320B Board as follows:

Table 38.	 THUM Wire Configuration for 320B 

320B THUM
26 Red
29 Black

12.	 Verify that all connections are secured and make sure the actuator is configured for 
“Network Mode” (Setpoint changes via THUM will not be accepted if not in proper 
mode), and then close the actuator.
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11.3	 Component Installation on MPA

NOTE:  

The following instructions apply to actuators installed in non-hazardous locations only.

1.	 Disconnect the actuator from the power source.

2.	 Open the cover to expose the internal electronics.

3.	 Locate the front cover of the MPA and open it to access the internal electronics.

4.	 Insert the Wireless HART THUM and a 3/4 to 1/4 conduit reducer into one of the access 
ports in the actuator control housing. Then, tighten securely, making sure not to 
damage the wires while turning.

Figure 75	 Wireless HART THUM in MPA

                               	

NOTE:  

Reducer bushings used for non-hazardous locations installation only. 
Teflon tape should be applied to both the THUM and reducer bushing threads to  
prevent galling.
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5.	 Using appropriate tools, verify that the internal pre-wired connections between 
the MPA TBM and the CAM16 P1 connector are as shown below. If the wires are 
disconnected on the TBM, connect them as shown:

Table 39.	 MPA Pre-Wired Connections 

CAM16 MPA
O- 20
O+ 21
I- 22
I+ 23

6.	 Next, connect the THUM wires to the TBM as shown in the following table:

Table 40.	 THUM Wires to TBM Configuration 

MPA TBM THUM
22 White
23 Yellow
26 Red
29 Black

7.	 Verify that all connections are secured and make sure the actuator is configured for 
“Network Mode” (Setpoint changes via THUM will not be accepted if not in proper 
mode), and then close the actuator.

11.4	 Component Installation on EHO

1.	 Disconnect the actuator from the power source and open the back cover to expose  
the STC.

2.	 Apply Teflon tape to both, the THUM and the reducer bushing threads to  
prevent galling.

3.	 Insert the Wireless HART THUM and a 3/4 to 1/4 conduit reducer into one of the access 
ports in the actuator control housing. Then, tighten securely, making sure not to 
damage wires while turning.

NOTE:  

Reducer bushings used for non-hazardous locations installation only.

4.	 Once the THUM is securely installed, wire as shown below:

Table 41.	 EHO and THUM Wiring Configuration 

EHO STC Connection THUM
9 24 VDC Red
10 0 VDC Black 1200 OHM Series Resistor
24 Shield Green (Optional)
43 HART (+) Yellow
44 HART (-) White

NOTE:  

Resistors and other required parts are available by ordering Part No. 87263 “Wireless HART 
THUM Kit”.
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Figure 76	 THUM on the EHO STC

                               	

5.	 Verify that all connections are secured and make sure the actuator is configured for 
“Network Mode” (Setpoint changes via THUM will not be accepted if not in proper 
mode), and then close the actuator.

11.5	 Component Installation on HQ

1.	 Disconnect the actuator from the power source and open the top cover to expose the 
internal electronics.

2.	 Apply Teflon tape to both, the THUM and the reducer bushing threads to  
prevent galling.

3.	 Insert the Wireless HART THUM and a 3/4 to 1/4 conduit reducer into one of the access 
ports in the actuator control housing. Then, tighten securely, making sure not to 
damage wires while turning.

NOTE:  

Reducer bushings used for non-hazardous locations installation only.

4.	 Once the THUM is securely installed, wire as shown below:

Table 42.	 THUM Component Wiring (1) 

CAM16 THUM
I- White
I+ Yellow
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Table 43.	 THUM Component Wiring (2) 

HQ THUM
P3-3 Red
P3-4 Black

Figure 77	 THUM Wiring in PCB

                               	

5.	 Verify that all connections are secured and make sure the actuator is configured for 
“Network Mode” (Setpoint changes via THUM will not be accepted if not in proper 
mode), and then close the actuator.
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Section 12:	 THUM Programming and 			 
		  Wireless Setup

12.1	 Set Up Gateway Internet Access for AMS Session

NOTE:  

A special crossover cable must be used for this application.

1.	 Connect crossover Ethernet cable between computer and Ethernet #1 port on 
Gateway.

2.	 On your PC, navigate to: Control Panel > View Network Connections > Local Area 
Connection > Properties > Internet Protocol Version 4 (TCP/IPv4) > Properties .

3.	 Select “Use the following IP Address” and enter 192.168.1.12 (subnet mask will come 
up) select Ok and then Ok on the next prompt.

4.	 Open Internet Explorer and enter the following address: HTTPS://192.168.1.10 and hit 
enter. (*If Security certificate message comes up, you may have to select “ Diagnose 
Connection Problem”).

5.	 Select “Continue to Website” and enter for Username “admin” and Password “default”.

6.	 Select “Explorer” in left margin to read devices (this process might take up to 15 
minutes).

12.2	 Set Up a Computer Using a HART Modem

1.	 Install all software/drivers necessary for your HART modem prior to connection.

2.	 Open AMS Device Manager and navigate to Configuration > Add > HART Modem > 
Install > Next > Next and select “Hand held device as secondary HART master”, then 
select the correct COM port for your HART modem.

3.	 Go to “Wireless HART adapter block” and check “include Wireless HART adapter” then 
click finish.

12.3	 THUM Programming – Join to Gateway Network 
Using a PC

1.	 Set up computer internet for Gateway “Refer to Appendix A -1”.

2.	 Plug HART modem into computer.

3.	 Open AMS and navigate to Device Connection icon > HART modem > THUM > to read 
the parameters.

4.	 Select Configure > Join Device to Network > Enter Network ID and enter the Network 
ID inside the cover of the Gateway, then click next.

5.	 Enter Join Key (Number shown on THUM tag). All Three remaining “Join Keys” are (8) 
zeros.

6.	 Select “Network Configuration” on AMS menu and select “Add”.
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12.4	 Running AMS to Change the Device Setpoint

1.	 Navigate and start your AMS Device Manager application.

2.	 For Username enter “admin” – leave password field blank.

3.	 Locate and select the “Device Connection View” in the middle of the toolbar.

4.	 Double click on Wireless Network to see devices.

NOTE:  

The message “Network disruption was detected” means no devices are sensed by gateway. 
If no devices show up on the screen, right click on Wireless Network and select Rebuild and 
Identify  hierarchy.

5.	 Expand Gateway > myNet > THUM and double click on the device Logo.

6.	 Set the “Time” in the lower left hand corner of the screen to “Current” from the drop 
down box and answer “Yes” when prompted to continue.

7.	 Expand “Online” on the Configure/Setup Screen > Detailed Setup > Valve Control > 
Setpoint and select the “Change Setpoint” method.

8.	 Select “Yes” and click next when the “Writing Setpoint requires placing the device in 
Out of service mode…” Prompt shows up.

9.	 Enter the desired Setpoint for the device and click “Next”.

10.	 After you receive the “Write Setpoint success” message, select “next”, then “finish” to 
complete the “Change Setpoint method”.

11.	 To select a different Setpoint, repeat Steps 2.7 – 2.10.

12.5	 Return Network Settings to Original Settings 
after AMS Session

1.	 On your PC, navigate to: Control Panel > View Network Connections > Local Area 
Connections > Properties > Internet Protocol Version 4 (TCP/IPv4) > Properties.

2.	 Select the option “Obtain an IP address automatically and click ok.

3.	 Your settings are back to their original configuration.
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Section 13:	 AMS Bulk Transfer

13.1	 Create and export Bulk User Configuration  
File Template

13.1.1	 Open AMS Device Manager and navigate to “View > User Configurations”. If necessary, 
use the “Window” menu to rearrange the windows on AMS to be able to see the User 
Configuration menu.

Figure 78	 Configuring AMS Suite

                               	

13.1.2	 From the User Configuration menu, right-click on the background and select “New”; 
then, navigate to the device and find the template for Manufacturer: Valve Automation 
and Type: CAM216. Select OK.

Figure 79	 User Configurations Menu

                               	

13.1.3	 After a few seconds, the device template should appear on the User Configuration 
screen. Rename the template and then right-click and select “Configure for Bulk 
Transfer”.
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Figure 80	 Configuring for Bulk Transfer

                               	

13.1.4	 On the “Configure for Bulk Transfer” Menu, click on the green arrow icon to select 
whether that parameter will be enabled/disabled for the bulk transfer. Enter the 
information on the blank space and then click save to save your changes.

Figure 81	 Enabling or Disabling a Parameter

                               	

13.1.5	 Navigate to AMS Device Explorer and right click on the “AMS Device Manager Icon” > 
Export > To AMS Device Manager Export File”

Figure 82	 Exporting the File

                               	

13.1.6	 On the Export menu, uncheck all other options except the user Configurations” and 
browse for your file to save to. Then, click on “Select…” button and on the “Select user 
configuration” uncheck the devices that you do not wish to configure.
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Figure 83	 Export Menu Options

                               	

13.1.7	 After selecting your device, click on to begin the export. This process might take some 
time depending on how many parameters are selected. When you receive the “Export 
operation Complete”, press OK to continue.

Figure 84	 AMS File Export
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13.2	 Bulk Configuration Transfer Utility Procedure

13.2.1	 To transfer parameter data from the user configuration with the bulk transfer utility, 
create a new spreadsheet on Microsoft Excel. On the spreadsheet, use column 1 
for “User Configuration” and Column 2 for “Host Tags”. Once all the information is 
entered, save the document.

Figure 85	 Transfering Parameter Data

                               	

13.2.2	 Before sending the configuration, the device must be placed into “Setup” mode, 
This can be done from AMS Device manager by opening the desired device DD and 
navigating to “Configure > Manual Setup > Detailed Setup” and use the configuration 
commands to place the device into “Setup Mode”

Figure 86	 Entering Setup Mode

                               	

13.2.2.1	Note that when device is this mode, Commands from the host will be 
ignored. You might to back to Overview Menu to verify the device is in setup 
mode.
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Figure 87	 Transfer Mode

                               	

13.2.3	 Navigate to “AMS Device Manager > Tools > Bulk Transfer utility”. Browse for the file 
name and enter the correct information for your spreadsheet. Press Begin to start  
the transfer.

Figure 88	 Start Transfer

                               	

13.2.4	 When transfer is completed; navigate to “Configure > Manual Setup > Detailed Setup” 
and use the configuration commands to exit setup mode and return the device to 
normal operation.

Figure 89	 Transfer Complete
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Section 14:	 Troubleshooting

14.1	 Communication Issues

Emerson HART CAM16/216 is equipped with 2 LEDs - D5 and D6, indicators for troubleshooting 
communication issues. Refer to the table below to verify proper installation and operation of 
CAM16/216.

Table 44.	 Known Communication Issues 

Issue Description Troubleshooting

Normal Operation 
(Communicating)

D6 yellow blinking indicates good 
communication between CAM16/216 
Board and Actuator, whereas  D5 red 
blinking indicates good communication 
between HART host and  
CAM16/216 Board

No action needed

Normal Operation 
(Standby)

D6 (yellow) indicates communication 
between CAM16/216 Board and Actuator.
D5 (red) indicates communication 
between HART host and CAM16/216 
Board, in Idle condition if not 
communicating with HART host D5 will be 
off and D6 will be blinking.
When actuator is communicating with 
HART master both LEDs would  
be blinking.

If device is in good status, a 
command to read parameters can 
be sent to verify that D5 and D6 
begin flashing.
 
If successful, device is functioning 
properly.

Bad ACM 
communication

D6 LED is not flashing and is continuously 
ON or OFF.

When D6 is not flashing; there 
is bad communication with the 
actuator. Verify that the CAM is 
properly aligned with the ACM 
connector and all connections are 
properly secured

Bad HART 
communication

D5 LED is not flashing and is continuously 
ON or OFF.

Verify connections as well as 
polarity of connections of J4 in 
CAM16 and J6 in CAM216.

Verify that proper current and 
voltage is applied to the  
HART segment.
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14.2	 Control Issues

Table 45.	 Known Control Issues 

Issue Description Troubleshooting

Can read status but 
cannot control.

Incorrect control mode configuration or 
control knob is in off mode.

Make sure control knob is set to 
Remote mode.

Verify if the device is properly 
configured for “Analog” when 
trying to control from AI 4-20mA 
or “Network” when attempting to 
send commands from host.

Analog control is not 
properly functioning.

When device is configured for analog 
control the 4-20mA signal does not allow 
full stroke control.

Calibrate the AI on the device; 
refer to the electric actuator 
manual for details.

Sending commands 
does not move the 
valve.

When sending Open, Stop, Close 
command or Setpoint (0-100%) the valve 
doesn’t respond.

Ensure that the actuator is 
properly configured for HART 
Block mode or HART Modulation 
(Setpoint) mode.

Valve does not move, 
yellow light flashing on 
LDM screen.

Incorrect control mode configuration or 
control knob is in off mode.

Make sure control knob is set to 
Remote mode.
 
Verify if the device is properly 
configured for “Analog” when 
trying to control from AI 4-20mA 
or “Network” when attempting to 
send commands from host.
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Section 15:	 Trademark Acknowledgements
1.	 DCMlink™ Software, AMS™ Intelligent Device Manager, Plant Web®, Delta V™ are 

the trademarks owned by one of the companies in the Emerson Process Management 
business platform of Emerson Electric Co. 

2.	 Emerson Process Management, Emerson, and the Emerson logo are the trademarks 
and service marks of Emerson Electric Co.

3.	 HART is a registered trademark of the HART Communication Foundation.

All other company and product names mentioned in this document are trademarks or 
registered trademarks of their respective companies.
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Section 16:	 Document Revision
Table 46.	 Revision Overview

REVISION DATE MODIFIED BY APPROVED BY DESCRIPTION
0.1 April 27, 2015 Aseem Mahesh Initial draft
0.2 May 27, 2015 Aseem Mahesh Updated review points
1 January 5, 2016 Charles Khalid Rico Mahesh Converted to new format



January 2016, Rev. 1
CAM216/16 IOM 

Doc. Number: ECM-402-0116

84

Appendix

Appendix

Appendix A:	 List of Certificates and Drawings

A.1	 Certificate of Registration HCF Verified

HART® is a registered trademark of FieldComm Group

 Certificate of Registration 
FieldComm Group Verified 

Valve Automation CAM16 
Manufacturer Product Name 

   
6060  E28B 

Manufacturer ID (Hex)  Expanded Device Type (Hex) 
   

7  01 
HART Protocol Revision  Device Revision (Hex) 

   
01  01 

Hardware Revision (Hex)  Software Revision (Hex) 
   

5/1/2015  FieldComm Group
Test Date  Verification Method 

The above product has successfully completed the validation process and meets the 
requirements to be “HART REGISTERED”. 

“HART REGISTERED” products conform to GB/T 29910.1-6-2013 and IEC 61158 standards.

Registration 
Number: L2-06-1000-441 

Registration 
Issue Date: Sept. 9, 2015 Approval: 
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A.2	 Wiring Diagram for Controlinc320B with  
Analog-CAM16-HART
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A.3	 Wiring Diagram for TEC2 -3PH-CAM216-HART
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Dubai 
United Arab Emirates 
T +971 4 811 8100 
F +971 4 886 5465

P. O. Box 10305 
Jubail 31961 
Saudi Arabia 
T +966 3 340 8650 
F +966 3 340 8790

24 Angus Crescent 
Longmeadow Business Estate  
East P.O. Box 6908; Greenstone 
1616 Modderfontein, Extension 5 
South Africa
T +27 11 451 3700
F +27 11 451 3800

EUROPE 
 
Berenyi u. 72- 100 
Videoton Industry Park 
Building #230 
Székesfehérvár 8000 
Hungary 
T +36 22 53 09 50 
F +36 22 54 37 00


